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Úvod do 3D dat



Co je to 3D model

DIGITÁLNÍ MODEL

Trojrozměrná reprezentace skutečného či uměle
vytvořeného tvaru ve formě digitálních dat

Věrný - reálný Upravený Smyšlený



Co je to 3D model

DIGITÁLNÍ MODEL

Počítačový soubor, případně více vzájemně propojených souborů

Digitální záznam
Obsahující informace o
tvaru objektu a další

Zobrazitelný ve
speciálních aplikacích



Co je to 3D model

DIGITÁLNÍ MODEL

Různé množství nesené informace

Bodový oblak

Nejobecnější formát 3D dat:

o soubor bodů definovaných trojrozměrnými
souřadnicemi (x, y, z)

o body mohou být opatřeny barevnou informací
o body mohou být opatřeny normálovým vektorem

o může být zobrazen
o mohou být měřeny vzdálenosti mezi body

o nevymezuje prostor

Bodový oblak

Body mraku opatřené
barevnou informací



POLYGONÁLNÍ SÍŤ

Je tvořena body, hranami, které je propojují, a jimi
vymezenými ploškami (facety, angl. faces):

o mnohostěn vymezující prostor

o může být zobrazen
o mohou být měřeny vzdálenosti mezi body
o prvky mohou být opatřeny barevnou informací
o model může být propojen se souborem textury

o nevymezuje prostor

Polygonální model (nalevo v umělém zabarvení,
napravo v podobě drátěného modelu)

Co je to 3D model



Co je to 3D model

Stínovaný model opatřený
barevnou informací

Nestínovaný model bez
barevné informace

Stínovaný model bez
barevné informace

Podoba závisí na metodě záznamu, editaci modelu a nastavení zobrazení



Malý úvod do 3D modelování

BAREVNÁ INFORMACE MODELU

Přiřazení barvy přímo jednotlivým prvkům modelu

Co je to 3D model?

Barevná informace
5 000 vrcholů

Barevná informace
30 000 vrcholů

Barevná informace
70 000 vrcholů



Malý úvod do 3D modelování

BAREVNÁ INFORMACE MODELU

Barevná textura

o samostatný obrazový soubor (např. jpg formát)

o kvalitní barevná informace nezávislá na rozlišení
modelu

o nutnost udržovat více propojených souborů

Co je to 3D model?

5 000 vrcholů



PŘESNOST DIGITÁLNÍCH MODELŮ

Míra shody mezi vzájemnou polohou vrcholů
modelu a vzájemnou polohou jim odpovídajících
bodů zobrazovaného objektu

ROZLIŠENÍ

Počet vrcholů modelu na jednotku
plochy (nejčastěji in2 nebo cm2)

DETAILNOST

Velikost rozlišitelných 
prvků

523 vrcholů/cm2

(70 Mb)
2 vrcholy/cm2

(0,2 Mb)

Dáno přesností záznamových metod a
následnými úpravami modelu

Co je to 3D model?



60 tis. polygonů/30 tis. vrcholů 5 tis. polygonů/2,5 tis. vrcholů

Se zvyšujícím se počtem polygonů modelu stoupá 
velikost souboru a nároky na výpočetní výkon 
potřebný pro jeho zpracování

Rozlišení je vždy kompromisem mezi technickými možnostmi a potřebnou detailností.

Co je to 3D model?



.ply
o Formát nese informaci nejen o geometrii

modelu, ale také informaci o barvě vrcholů
a polygonů

o Může jít jak o mrak bodů, tak o polygonální
model

o Může být propojen s texturou

.obj
o Formát nese informaci o geometrii

modelu
o Může nést informaci o barvě a

vlastnostech materiálu
o Může být propojen s texturou
o V laboratoři nejčastěji užívaný

Co je to 3D model? – formáty 3D modelů

.stl
o Formát pro stereolitografii (3D tisk) - vyžaduje uzavřené modely.
o Seznam normál a vrcholů polygonů. Neobsahuje žádnou informaci o barvě.
o Dva formáty Ascii a Binary (program při exportu dovolí upřesnit formát).
o Ascii se liší ve struktuře souboru (je přehlednější, ale je náročnější na velikost

paměti).
o Pokud polygonální sítě obsahují díry, některé programy hlásí chybu.



Neexistuje jediná metoda, vhodná pro všechny typy objektů a zaznamenávající všechny vlastnosti!!!

Snímání 3D dat

Vnější tvar a vnitřní struktury Vnější tvar Barevná informace

Objemové snímání (CT a MRI) Povrchové skenery a fotogrammetrie



Povrchové snímání – skenery a fotogrammetrie

Snímání povrchových 3D dat

o omezeno na povrch objektů

o relativně levné a přenosné (od tisíců do jednotek milionů korun)

o zdraví neohrožující

o primárním výstupem jsou přímo 3D modely nebo jejich prvky 

o přesnost a rozlišení jsou dány technickými možnostmi použitých přístrojů  - až setiny mm 



Kontaktní skenery

o Efektivní metoda pro záznam prostorové polohy 
diskrétních bodů a křivek na principu fyzického kontaktu

o Přesný záznam malého objemu dat

o Použitelné na všechny pevné materiály

o Pro snímání živých osob pomalé

Snímání povrchových 3D dat



Bezkontaktní metody – skenery a fotogrammetrie

o Bez fyzického kontaktu s objektem zaznamenávají velké 
množství informací o tvaru a případně o barvě

o Tvoří realistické digitální kopie objektů

o Dobře zaznamenávají povrch kostí i vnější povrch těla (některé)

o Záznam o rozlišení a přesnosti až desítek mikrometrů

Snímání povrchových 3D dat

TOF skenery Triangulační skenery Fotogrammetrie



Metody snímání povrchových dat

TOF a fázové skenery

o Měří scénu na základě doby letu laserového paprsku nebo změny jeho fáze

o Velmi rychlý záznam větších scén (až 10 000 bodů/s)

o Pro kosterní pozůstatky nevhodné – designováno především pro účely 
mimolaboratorní 3D dokumentace

Snímání povrchových 3D dat



Metody snímání povrchových dat

Triangulační skenery 

o Prostorovou polohu bodů vypočítávají na základě 
triangulace polohy vůči dvěma triangulačním bodům

o Vhodné pro objekty ve velikostním rozmezí mm až ca 
3 metrů

o Povrch musí být triangulován – musí být dostupný z 
obou referenčních bodů

Aktivní skenery

Snímání povrchových 3D dat

o Aktivně promítají světelný vzor a snímají jeho deformaci

Pasivní skenery

o Triangulují souřadnice ze dvou a více 
fotografií, pořízených z fixních poloh



Aktivní skenery s laserovým paprskem

o Promítají zpravidla jednu či více linií

o Rozlišení až v řádu setin mm 

o Záznam zpravidla v řádu jednotek či desítek sekund

Snímání povrchových 3D dat



Aktivní skenery se strukturovaným světlem

o Bílým světlem promítají složitější obrazce

o Rozlišení až v řádu desítek mikrometrů (obecně větší než 
laserové)

o Záznam zpravidla v řádu sekund

Snímání povrchových 3D dat



Snímání povrchových 3D dat

Optické, pasivní skenery

o Triangulují prostorové souřadnice z dvou a více snímků, pořízených 
synchronizovanými kamerami

o Potřebují rozpoznatelné prvky

o Velmi rychlé, designováno především na snímání živého člověka

Skenery Vectra



Soustavy synchronizovaných fotoaparátů

Snímání povrchových 3D dat



Přístroje designované pro snímání různě velkých pracovních oblastí

Snímání povrchových 3D dat



Průběh snímání
o Zpravidla není možné nasnímat celý povrch 

najednou

o Pořizuje se více skenů z více stran

Ořezání
o Odstranění 

nechtěných částí

ZAROVNÁNÍ
• Zarovnání dílčích skenů

SLOUČENÍ SÍTÍ

• Vygenerování nové sítě

Snímání povrchových 3D dat



Metody snímání povrchových dat

Fotogrammetrie
Generování 3D dat ze série fotografií pořízených jedním 
přístrojem, zachycujících digitalizovanou scénu z různých 
úhlů pohledu

Snímání povrchových 3D dat

+ desítky dalších

Software
o rozezná stejné prvky na 

různých fotografiích
o na základě vzájemné 

polohy uspořádá fotografie 
v prostoru

o trianguluje trojrozměrnou 
podobu zaznamenaného, 
včetně barevné informace 



Metody snímání povrchových dat

Metody

Asymetrie

Různí jedinci

Snímání povrchových 3D dat

Fotogrammetrie
o Vysoká míra flexibility
o Přesnost srovnatelná se 

skenery
o Pouze na stabilní objekty s 

povrchovou texturou



o Metody zaznamenávající rozložení hmoty ve 
snímaném objemu – záznam vnitřní struktury, vnější 
podoby, ale ne barevnosti

o Produktem nejsou 3D digitální modely!!!

o Relativně velké a finančně náročné

o Náročné na umístění, personál...

Metody snímání povrchových datSnímání objemových 3D dat

Výpočetní tomografie Magnetická rezonance

o Záznam s pomocí rtg o Záznam na principu 
změn spinů elektronů v 
magnetickém poli



Metody snímání povrchových dat

Výpočetní tomografie
o Měří pracovní pole pomocí rtg paprsků – ionizující 

a potenciálně nebezpečné

o Běžné lékařské přístroje rozlišení od ca 0,35 mm, 
specializované uCT a nanoCT až do desetin 
mikrometru

o Se zvětšujícím se rozlišením klesá velikost 
pracovního pole (až na jednotky mm)

Kováčová 2016
Jazylka
CT, voxel 0,01mm

Snímání objemových 3D dat



Metody snímání povrchových dat

Výpočetní tomografie
o Obecně velmi dobrý kontrast pro kosti bez 

měkkých tkání i kosti kryté měkkými 
tkáněmi a jinými překážkami (ne kov)

o Horší kontrast pro měkké tkáně

o Přítomný kov může být zdrojem artefaktů –
poškození záznamu

Harvig et al. 2012

Snímání objemových 3D dat



Výpočetní tomografie

Snímání objemových 3D dat



Magnetická rezonance

o Běžné rozlišení až 1mm, speciální přístroje pak 
desetiny milimetru

o Nejlepší kontrast pro látky obsahující různé podíly 
vody a tuku – měkké tkáně

o Kosti často špatný kontrast

Snímání objemových 3D dat



Primárními daty jsou souřadnice 
povrchových bodů a případně 
barevná informace

Primárním výstupem skenerů a 
fotogrammetrie jsou 3D data ve 
formě oblaku bodů nebo více či 
méně hotové polygonální modely

Povrchové skenování Objemové snímání

Primárním jednotkou záznamu jsou voxely, části 
objemu rozdělující snímaný prostor do pravidelné 
trojrozměrné sítě

Metoda měří danou charakteristiku v objemu voxelu
(dále nedělitelného)

Na snímcích jsou voxely zastoupeny pixely a jejich jas 
vyjadřuje hodnotu dané charakteristiky voxelu

Objemová a povrchová data



Objemová a povrchová data

Biologické objekty mají kontinuální charakter, jsou ale 
zaznamenány do konečného počtu voxelů

Daisy Ridley



Objemová data

Objemová data se dají zobrazit jako tzv. 
multiplanární projekce nebo s pomocí 
metod objemového zobrazení

Nejde o polygonální modely

Objemová a povrchová data

Maximum 
instensity
projection

Multiplanární rekonstrukce



Objemová data

Modely se vytvářejí procesy segmentace a 
renderování 

Objemová a povrchová data

Segmentace

Vymezení oblastí, které zobrazují objekt, 
jehož model chceme vytvořit – definujeme 
průběh budoucího modelu v jednotlivých 
řezech

Renderování

Vytvoření polygonálního modelu, jehož 
povrch kopíruje hranice vyznačení na 
snímcích

Spolu s původním rozlišení ovlivňují přesnost a detailnost budoucího modelu!!!



Zdroj chyb

Vymezení 2D linie v rastrovém snímku – někudy stěna 
modelu vést musí, ale ve voxelech ostré hranice nejsou

Segmentace a renderování



Hrubé modely  vytvořené skenerem mohou obsahovat řadu 
nedostatků:

o nežádoucí části (skener snímá vše, co je v zorném poli)

o nekvalitně nasnímané oblasti

o defekty, artefakty skenování

Segmentace a renderování



MeshLab

Open-source program zaměřený na zpracování a editaci polygonálních modelů.

Import: PLY, STL, OFF, OBJ, 3DS, COLLADA, PTX, V3D, PTS, APTS, XYZ, GTS, TRI, ASC, 
X3D, X3DV, VRML, ALN
Export: PLY, STL, OFF, OBJ, 3DS, COLLADA, VRML, DXF, GTS, U3D, IDTF, X3D

+
Velké množství nástrojů pro 
editaci bodových mraků a 
polygonálních sítí jako celku. 

Pracuje s formáty .ply a .obj
obsahujícími texturu.

-
Časté sekání a poruchovost ve spojení s 
některými operačními systémy. 

Někdy s texturou nepracuje.

Omezené možnosti lokálních úprav.

Meshlab



Blender (aktuálně v2.78a)
Open-source program pro modelování a vykreslování počítačové 
grafiky

+
Velké množství nástrojů pro celkovou úpravu 
3D modelů, editaci textur, vykreslování a 
široké možnosti animace.

Dostupný na velkém množství platforem.

-
Pro nezkušené uživatele až 
příliš složitý.

Vysoká výpočetní náročnost.

Meshlab



Navigace
LMB - otáčení
Ctrl + LMB – posouvání
ZOOM –
přibližování/oddalování

Shift + ZOOM – změna FOV 
(field of view)
Ctrl + h – návrat k originální 
poloze

LMB + Ctrl + Shift –
ovládání osvětlení

Meshlab



Import dat
File > Import > Import Mesh
nebo přetažením z průzkumníka souborů

Projekt je jednoduchý textový soubor (přípona .mlp), 
obsahuje pouze cesty k jednotlivým modelům, případně 
roto-translační matice, ne už záznamy jejich editace, 
definované body atp!!! V případě, že změníme cestu k 
modelům, projekt nenačteme!!!!!

Seznam importovaných 
objektů a nastavení jejich 
vykreslování.

Layer Dialog

Obecné požadavky na pojmenovávání modelů:
V cestě ani v názvu modelu nepoužívejte mezery a diakritiku
C:\modely_cviceni\H123_superior.stl

Pokud přejmenujeme vzájemně propojené soubory (např. obj s 
texturou), musíme změnit i odkazy (cestu) v samotných 
souborech.

Meshlab – rozhraní a import souborů

Historie příkazů



Editované a neuložené 
modely jsou v Layer Dialog 
označeny hvězdičkou

Export polygonálních modelů 
File > Export Mesh...

Pokud pozměníme model, případně jej transformujeme, v 
Layer Dialog je onačen hvězdičkou – to znamená, že 
model byl změněn, ale ne uložen!!! Změny jsou uloženy 
pouze pokud uložíme/exportujeme samotný model, ne 
projekt.

Zadáme formát 
souboru a umístění

Označení prvků modelu, které budou 
součástí modelu

Color je barevná informace přiřazená k 
vrcholům a facetám modelu. Pro uložení s 
texturou musejí být zaškrtnutá pole 
TexCoord.

Název připojené 
textury (někdy při 
změně padá)

Meshlab – import a export programů



Aplikace MeshLab umožňuje exportovat náhledové okno ve vysokém
rozlišení v různých formátech 2D grafiky

1) nastavíme požadovaný náhled

2) otevřeme dialogové okno Save snapshot

Cílový adresář

Název souboru

Nastavení rozlišení výsledného snímku v 
násobcích rozlišení obrazovky

Meshlab – export náhledů



Redukce rozlišení může být provedena na začátku editace, pokud rozlišení modelu 
klade přílišné nároky na výpočetní výkon a čas. Zároveň by se mělo ponechat co 
největší, aby bylo zachováno co největší množství informace pro editační kroky.

MeshLab – Redukce počtu polygonů bez přepočtu textury
(Filters > Remeshing, Simplification and Reconstruction > Quadric Edge Collapse
Decimation...)

Optimal position of simplified vertices – výsledný 
model bude obsahovat pouze vrcholy, které 
tvořily původní objekt. Nebudou generovány 
nové pozice vrcholů na základě algoritmu.

Specifikujeme počet polygonů výsledného 
modelu nebo procento redukce

Preserve Normal, Preserve Topology, 
Preserve Boundary – volby zabraňující 
větším změnám v geometrii modelu. 
Zůstane zachováno směrování polygonů, 
nebudou redukovány výčnělky modelu 
nebo zaplňovány díry.

Redukce neprobíhá 
rovnoměrně po celém 
povrchu objektu. 
Nejdříve jsou 
zjednodušeny oblasti s 
vyšší hustotou 
polygonů!!!

Meshlab – redukce modelů



MeshLab – Redukce počtu polygonů modelů s texturou
(Filters > Remeshing, Simplification and Reconstruction > Quadric
Edge Collapse Decimation (with texture))

Meshlab – redukce modelů



Odstranění nežádoucích částí funguje podobně jako mazání v programech pro
editaci fotografií. V prvním kroku jsou výběrovými nástroji označeny části modelu a
ve druhém jsou vymazány.

1) K označení polygonů a vrcholů pro jakoukoliv 
editaci slouží nástroje:

„Select vertexes“ a „Select Faces in Rectangular region“ 
Označení prvků rámečkem.

„Z-Painting“
Označení štětcem, od ruky.

2) Vybrané části modelu odstraníme nástrojem pro 
smazání polygonů a vrcholů

Na některých počítačích tyto nástroje 
nefungují správně – počítač se zasekává. 

Meshlab – odstranění nežádoucích částí modelu



Každý model je umístěn na konkrétním místě vzhledem ke svému souřadnicovému
systému (dáno hodnotou souřadnic bodů)

Při nastavování zobrazení se pohybuje kamerou, resp. modelem včetně jeho
souřadnicového systému – pozice modelu se nemění

MeshLab – Manipulators Tools
• T, R, S – zvolíme požadovanou 

transformaci
• transformujeme při stisknutém LMB
• transformaci potvrdíme Enter

Tranformací je na objekt aplikována tzv. 
roto-transformační matice

Matice je součást projektu. Při načtení je objekt podle ní orientován, 
ale samotné souřadnice jeho vrcholů zůstávají nezměněny!!! 
Změna musí být na objekt aplikována (LMB na název objektu v Layer
Dialog > Freeze Current Matrix)

Meshlab – odstranění nežádoucích částí modelu



Measuring tool
Kliknutím LMB na model definujeme dva body 
definující vzdálenost

Během měření se s modelem nedá otáčet

Nástroj zobrazí hodnotu jejich přímé vzdálenosti 

Data se nikam neexportují a při opětovném použití 
původní hodnota zmizí

Meshlab – měření vzdálenosti



Digitální modely nemusejí mít reálné rozměry (např. modely z fotogrammetrie)  pokud mají být 
využity pro měření, musejí obsahovat měřítko (přip. známý rozměr), podle kterého můžeme 
transformovat jejich velikost

Nastavení měřítka
1) za pomoci nástroje Measuring Tool změříme známý rozměr na modelu 

koeficient změny velikosti =
skutečná vzdálenost

naměřená vzdálenost

Skutečná vzdálenost – 17 mm
Naměřená vzdálenost – 16,02 mm

Poměr = 1,06

Meshlab – kalibrace



Landmark

Freeware - http://www.idav.ucdavis.edu/research/EvoMorph)

Aplikace pro analýzu, interpretaci a vizualizaci morfometrických dat.

Export tvaru a polohy bodů, křivek nebo definovaných ploch (XYZ souřadnice) na 
importovaných 3D modelech a export jejich prostorových souřadnic. Prvky jsou 
označeny jako tzv. primitives

Vstupním formátem je ply

http://www.idav.ucdavis.edu/research/EvoMorph


Program pracuje s tzv. projekty. Nativními soubory programu (.land), do 
kterých jsou importovány trojrozměrné modely (.ply) nebo soubory obsahující 
souřadnice bodů (NTS - .dat, .pts) a jejichž součástí jsou i všechny výstupy.

Všechna data jsou inkorporována v souboru projektu – máme jediný soubor!

Importovaná data mohou  být 
zobrazena v jednom ze dvou 
náhledových oken (RMB na daný 
soubor ve stromu > Load into...). 

Importovaná data 
jsou vypsána ve 
stromu projektu

Landmark



Landmark



RMB na data ve stromu projektu > Export

Body i vzdálenosti se exportují pouze v podobě 
souřadnic bodů

Landmark



Landmark – export dat



Prostřednictvím vlastností vzdáleností 
(Edit primitives) můžeme model 
kalibrovat.

1. definujeme vzdálenost

2. V edit primitives definujeme 
skutečnou vzdálenost v poli „actual
measured distance“

Modely ze specializovaných skenerů jsou většinou kalibrované – odpovídají reálným 
jednotkám. Z fotogrammetrie ale ne a také v průběhu editace může dojít k chybě.

V dialogovém okně 
Primitive type musí být 
nastaveno Dimensions

Landmark – škálování


